
VisualWRAP Help Contents

Introduction ___________________________________________________________ 2

System Requirements____________________________________________________ 3

Basic Concepts _________________________________________________________ 4

Patterns and Scripts _____________________________________________________ 5

Thread Colors_________________________________________________________ 12

The Flat View Window _________________________________________________ 14

The Zoom Window_____________________________________________________ 16

The 3D View Window __________________________________________________ 16

The Pattern Script Window ______________________________________________ 18

The Script Builder _____________________________________________________ 21

The Taper View Window ________________________________________________ 23

The Preferences Window________________________________________________ 25

The Tools Menu _______________________________________________________ 27

Wrapping Instructions __________________________________________________ 27

Frequently Asked Questions _____________________________________________ 28

Support ______________________________________________________________ 28

Screen Shots __________________________________________________________ 28



Page 2 of 31

VisualWRAP Help File
Copyright 2001, 2002 David Boyle

www.visualwrap.com

VisualWRAP Help

Introduction

Welcome to the VisualWRAP 1.0 Help System!

This help file teaches you how to use VisualWRAP.  It assumes you have a basic 
knowledge of cross wrap patterns.  If you are new to cross wraps then check out the 
website www.visualwrap.com for more information and useful links.

VisualWRAP is a software tool for working with decorative cross wraps for fishing rods.
It was designed to make working with thread patterns much easier.

? Have you ever looked at a decorated fishing rod and wished you had a better 
understanding of how those cross wrap patterns were formed?

? Ever wondered what a certain pattern would look like in different colors?
? Ever sat down and spent hours working from a pattern in a book, only to find out 

it doesn’t look the same on the rod as it does in the picture?
? Ever wanted to design your own wraps?

VisualWRAP was designed to address each of these issues.

VisualWRAP on its own can be used to create new wraps or modify existing ones.  The 
software is supplied with a number of patterns to get you started.  Perhaps the most 
exciting aspect of the software is the ease with which patterns can be shared.  Log on to 
the internet, go to www.visualwrap.com and take a look at the pattern library.  You now 
have access to patterns contributed by rod builders from around the world.  You can view 
and download the patterns you like, or even contribute your own for others to use.

VisualWRAP is an integrated set of tools for working with many aspects of cross wrap 
patterns.  Some parts of the software are quite involved.  Like anything new there is a 
learning curve to understand how various results can be achieved.  Please refer to these 
Help notes and the Help Wizard until you are comfortable with VisualWRAP.  I have 
done my best to make VisualWRAP as intuitive and straightforward as possible, but there 
is always room for improvement.  Please send your feedback or suggestions to one of the 
email addresses listed on the website.

This program is dedicated to Caroline (my wife) and family who are always so very 
supportive.
David Boyle  2001
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System Requirements

? MS Windows (win95..winXP)
? MS Internet Explorer (4.01 or better)
? Cortona VRML Client (available from www.parallelgraphics.com)
? P166 IBM PC or compatible
? 12 MB Hard Disk space (6MB for VisualWRAP plus 6MB for Cortona Viewer)
? Internet access is recommended in order to visit the pattern library at www.visualwrap.com
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Basic Concepts

A cross wrap is a set of threads wrapped onto a rod in a certain sequence so that the result 
is a pleasing pattern.  VisualWRAP has a scripting language which lets you define a set 
of instructions for the software to follow.  The instructions tell the software where to 
place threads, how many threads to use, colors etc.  A pattern is a collection of 
instructions referred to as a Script.

Once you create a script or load a new one, use VisualWRAP to “wrap” the pattern on the 
screen.  VisualWRAP draws lines to represent threads.  These lines are drawn in a box 
that represents a rod.

As an example, imagine a rod that has a single 
thread spiraling up its length.  Take that rod, slice 
it and lay it out flat.  (Assume the thread sticks to 
the rod.)  The result is a flat area with the thread 
lying straight.  VisualWRAP uses a Flat View 
window to represent this.

The Flat View Window is useful for setting up 
patterns.  You can choose to show threads being 
wrapped one at a time, thereby seeing how the 
thread pattern forms.

Once the pattern is wrapped you can use the 3D 
Viewer to see what the pattern will look like on a 
real rod.  What VisualWRAP does is take the 
image from the Flat View window and curl it 

around a 3D rod.  The rod spins around and can be moved using the mouse, so you can 
view it from any angle.

When you are happy with the way the pattern looks you can use VisualWRAP to 
calculate the spacing measurements to use when laying out your pattern on a real rod.
The Flat View window assumes the rod has no taper, which may not be the case.  Use the 
Taper View window to show the pattern as it should appear on a tapered rod.
VisualWRAP adjusts the pattern, showing the result as an image.  The Spacing List 
shows a list of centre measurements.  Both the image and the list may be printed to assist 
you in laying out the pattern.

That covers the basics.  The following sections discuss each part of the software in detail.
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Patterns and Scripts

This section explains the language of VisualWRAP scripts.

Please note – you do not have to learn the syntax in order to use VisualWRAP.  If you 
want to edit patterns without modifying scripts directly, use the Script Builder.  The 
Script Builder is a graphical utility that edits and generates script according to your 
selections.  It also has a help wizard associated with it to guide you through the task of 
creating scripts.

Conventions

The VisualWRAP scripting language is based on key words in common use by 
rodbuilders.  The following conventions are assumed:

The rod is in wrapping position, which means horizontal, with the butt on your left and 
the tip on your right.

“Up” the rod means “starting at the butt (handle) end and heading towards the tip”.  A 
thread wrapped “Up”  the rod would look like the thread in Diagram 1 in the Overview 
section.

“Down” the rod means “starting at the tip end and heading towards the butt”.  A thread 
wrapped “Down” the rod would form a cross with a thread wrapped “Up” the rod.

“Left” and “Right” refer to the rod in fishing position, which means upright, with the tip 
pointing to the sky (hopefully with a curve in it due to a nice fish!). “Left“ means “to
your left hand side in fishing position”, and “Right”  means “towards your right hand 
side”.  When the rod is placed in wrapping position, “Left”  becomes “towards the sky”
and “Right” becomes “towards the floor”.  There is much potential for confusion here, so 
consistency is important.  When you look at the Flat View window, “Left”  means 
“towards the top of the screen” and “Right”  means “towards the bottom of the screen”.
Just remember that we are treating the rod as if it is in wrapping position.  If you always 
use the Script Builder when working with scripts there is no confusion as you can select a 
graphical button to specify a direction.

Layout and Progression

Cross wrap patterns are made by wrapping threads in a defined sequence.  Every time a 
new set of threads is wrapped it is called a “Pass”.  A typical pattern may consist of many 
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passes.  A pattern is started by putting the first threads down.  These are the “Layout”
threads.  Each new pass consists of putting similar layout threads in a position slightly 
different to the last set.  The position of the new threads relative to the last is called the 
“Progression” of the pattern.  Eg. If each new pass is to the right of the last then the 
progression is “to the right”.

A cross wrap pattern may consist of a single layout, or many layouts.  Sometimes several 
layouts are grouped together and wrapped at the same time.  Other times one layout is 
wrapped to completion before the next layout is started.  The many different possible 
combinations of layouts and sequences lead to the great variety of patterns that exist.
VisualWRAP lets you experiment with any combination of layouts and progressions.

Structure of Scripts

VisualWRAP script describes patterns in terms of Layouts and Progressions (referred to 
as L&P’s).  A typical line of script consists of one layout and its progression.  Grouping 
is achieved using “Sections”.  All lines of script in the same section are wrapped at the 
same time (in sequence).  Once one section is complete, the next one is wrapped.  A 
pattern consists of any number of sections.  Each section consists of any number of 
L&P’s.

Following shows the structure of an example pattern script:

Title: Title of pattern
Section: Name of section 1
L&P 1
L&P 2
L&P 3
Section: Name of section 2
L&P 4
L&P 5

L&P means “Layout and Progression” and follows the structure:
[Layout] [Co-ordinates] [Spool(s)] [Co-ordinates 2] [Spools 2] [Progression 

Direction] [Progression Type] [Passes] [Spacing] [Comment]

Note 1: The square brackets aren’t part of the syntax
Note 2:  [Co-ordinates 2] and [Threads 2] are only used when [Layout] is Box

Title and Section are key words recognized by VisualWRAP.  The syntax for L&P’s will 
be discussed shortly.  In this example, L&P 1, 2 and 3 would be wrapped together in the 
order 1, 2, 3, 1, 2, 3, 1, 2, 3 etc. The number of times this happens depends on the number 
of passes required.  Each L&P may have a different number of passes specified.  Once 
the number of passes is reached then that L&P is no longer wrapped.  The section is 
completed once all of the passes for all of the L&P’s are made.
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Example: For the example pattern script above, say L&P 1 had 3 passes specified, L&P 2 
had 5 passes specified, and L&P 3 had 2 passes specified.  The wrapping order for 
Section 1 would be: L&P 1, 2, 3, 1, 2, 3, 1, 2, 2, 2.  Notice how L&P 1 is wrapped 3 
times, L&P 2 is wrapped 5 times, and L&P 3 is wrapped twice, as required.

Once Section 1 is wrapped, Section 2 begins.  An example of where Sections are useful is 
when creating a background in a closed wrap (a closed wrap is where none of the rod or 
underwrap shows through the pattern, and individual patterns appear isolated from each 
other).  The first sections generally create the pattern and the last section creates the 
background, hiding the threads that connect individual patterns.

Script Syntax

This section describes what each key word in a VisualWRAP script means.  It is not 
necessary to learn this syntax.  It is much easier to use the Script Builder (and Script 
Builder Help Wizard) to create and edit a script than it is to type a script directly.

Order and Case-Sensitivity

When creating script for L&P’s, the order of key words is important.  VisualWRAP 
expects each line of script to contain key words in certain positions.  If you get this order 
wrong, when you try to wrap the pattern VisualWRAP will give you a message that it 
expected to see a certain key word and couldn’t find it.  Simply fix your script so that it 
meets what VisualWRAP expects, then try wrapping again.

VisualWRAP script is not case-sensitive.  It recognizes capitals and lower case letters.
The Script window automatically formats pattern scripts.  See the Pattern Script Window 
section for more details. 

Layout

Layout threads are the starting threads for a pattern (or part of a pattern).

Four standard layouts are supported: Thread_Up, Thread_Dn, Cross and Box.
? Thread_Up is a thread spiraling up the rod.
? Thread_Dn is a thread spiraling down the rod.
? Cross is a combination of a Thread_Up and a Thread_Dn layout.
? Box is a combination of two Cross layouts.

Co-ordinates
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Co-ordinates are used to let VisualWRAP know 
where to place threads.  VisualWRAP needs to 
know two things when placing threads:

1. The co-ordinate through which the 
thread(s) must pass

2. The angle at which the thread must be laid 
(spacing factor).

Diagram 2 shows the co-ordinate system used by 
VisualWRAP.  The Flat View window can be 
made longer or shorter to see more or less of a 
pattern.  When the window is at minimum size it is 
a square with sides of 100 units.  The vertical side 
of the Flat View window represents the 

circumference of the rod.  Create your patterns using the minimum size for the Flat View 
window.

Threads on the screen are slightly more than 1 unit wide, and when they are wrapped 
side-by-side they overlap slightly.  When you use single threads in a pattern, you may 
find occasionally they become hidden by nearby threads.  In this case it may be necessary 
to use a thicker thread (see the Thread Width properties on the “Threads” tab of the 
Preferences window), or possibly use band of two threads rather than a single thread.

For layouts of type Thread_Up, Thread_Dn and Cross, the syntax used to indicate co-
ordinates is X a Y b, where a and b are the x and y co-ordinates.
For Box layouts, the syntax for co-ordinates is X1 a Y1 b …..X2 c Y2 d, where a and b 
are the co-ordinates of the first corner, and c and d are the co-ordinates of the second 
corner.

Spools

VisualWRAP scripts use spool numbers rather than color names to define which threads 
to use.  For example, a pattern might use Spool 1 for the background.  Spool 1 can be 
assigned any color you choose, but this assignment is saved as part of your VisualWRAP 
configuration, not as part of the pattern.  (It is possible to have VisualWRAP load the 
colors the pattern was created with – see the Loaded Colors properties on the “Threads”
tab of the Preferences window),

The syntax used to specify spools is Spool_Up n or Spool_Dn n, where n is 1..8

Spool_Up is used in conjunction with the Thread_Up layout.  The syntax is Spool_Up 
followed by a space and the number of the spool to use (1..8).
Spool_Dn is used in conjunction with the Thread_Dn layout.  The syntax is Spool_Dn 
followed by a space and the number of the spool to use (1..8).
When the layout is Cross or Box, both Spool_Up and Spool_Dn are required.
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Progression Direction

The Progression Direction defines where to move the next threads, relative to the layout 
threads, every time a new wrapping pass is made.
The syntax is Up, Down, Left, Right, In or Out.
Note:

? Up means “towards the tip.”
? Down means “towards the butt or handle.”
? Left means “towards the sky with the rod in wrapping position.”
? Right means “towards the ground with the rod in wrapping position.”
? In means “towards the inside of a box.” If you think of a box as two crosses, then In means the 

crosses become closer together. In only has meaning when a box layout is used.
? Out means “to the outside of the last threads.”  If the layout is a box then the box grows outwards.

If the layout is a Thread_UP, Thread_Dn or Cross, then those layouts grow outwards as well.  The 
software repeats these layouts in the + X and – X directions.  The layouts have the appearance of 
becoming thicker.

Progression Type

Three types of progression are supported: Band, Plus and Minus.
Band n means “use a band of n threads on every pass.” Eg. Band 3 means a fixed band 
of 3 threads.
Plus n means “on each pass, use n more threads than the last pass.” Eg. Plus 1 means 
increase the width by 1 on each pass.
Minus n means “on each pass, use n less threads than the last pass.”  Eg. Minus 2 means 
decrease the width by 2 on each pass.

With each progression type it is necessary to define the starting number of threads.  The 
syntax Init# n specifies how many threads to start with.

For a Band progression, the first pass uses the number of threads specified by Init# n.
The remaining passes use the number of threads specified by Band n.
For Plus or Minus progression, the width of the first pass uses the number of threads 
specified by Init# n.  The remaining passes use more or less threads accordingly.

Note: The technique of combining a Plus or Minus progression in the same section of a 
pattern as a Band progression will lead to a pattern which curves.

Passes
Every time a new set of threads is wrapped it is called a Pass.  Syntax is Passes followed 
by a space and the number of passes to make.

Spacing
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The angle of the 
thread
determines the 
spacing of
patterns on the 
rod. “Square”
spacing means 
threads cross at 
right angles, and 
patterns will be 
repeated along 
the rod at a 
spacing equal to 
the
circumference
of the rod.

VisualWRAP uses a Spacing factor to calculate thread angles.  A spacing of 1 
corresponds to a square pattern.  A spacing of less than 1 corresponds to compression, 
where patterns will appear bunched closer together along the rod.  A spacing of greater 
than 1 corresponds to elongation, with patterns appearing more spread out along the rod.

The spacing factor is interpreted by VisualWRAP as being the thread gradient, equal to 
(rise/run) or (y distance) / (x distance).

Diagram 3 shows three threads passing though X 0 Y 100 on the Flat View window, each 
with a different spacing.  You can combine threads of different spacing in the same 
pattern, but most patterns use the same spacing for all threads.

The syntax used to indicate spacing is % n, where n is between 0 and 10.

Comment

You can add comments to the script to make it easier to understand.  When you wrap the 
pattern, one of the Wrapping Preferences allows you to display line comments while 
wrapping.  As each line of the script is being wrapped, the comment associated with that 
line is displayed on the screen, sort of like a running commentary.   You can use this 
feature to help you debug patterns as you edit them, or as an educational tool when 
demonstrating patterns to others.

Syntax for a comment is ! (exclamation mark) followed by a space and your comment.
Note 1 – you can also use the comment symbol to “mask out” lines of script as you work 
with them.  If you put the comment symbol (!) followed by a space at the start of a line in 
your script, VisualWRAP will ignore that line when it wraps the pattern.
Note 2 – If you comment out a line, this can confuse the Scope setting (explained in the 
Pattern Script Window section).
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Examples of script syntax

Syntax for Thread_Up and Thread_Dn :
Thread_Up X 50 Y 50 Spool_Up 3 Up Band 1 Init# 2 Passes 10 % 1 ! descriptive
comment
This specifies a thread spiraling up the blank, passing through the point (50,50), using 
spool 3.  The layout is initially 2 threads wide, and on each pass a single thread will be 
placed on the up side of the last thread (ie. towards the tip).  10 passes will be made, and 
square (=1) spacing is used.

Syntax for a Cross is similar, but a second Spool is needed.
Cross X 10 Y 10 Spool_Up 8 Spool_Dn 1 Right plus 1 init# 1 passes 3  % 1.1 !
descriptive comment
This defines a layout of two threads (a cross) passing through the point (10,10), using 
spool 8 for the thread spiraling up the rod, and spool 1 for the thread spiraling down the 
rod. Each new pass will see threads being placed towards the ground when the rod is 
wrapping position, and a total of 6 crosses will be wrapped (ie. 1 on the first pass, 2 on 
the second and 3 on the third due to the Plus 1 progression.)  The pattern will be slightly 
elongated along the axis due to the 1.1 spacing.

Syntax for a Box layout is similar to that of a Cross, but two sets of co-ordinates and two 
sets of spools are needed.
Box X1 19 Y1 50 Spool_Up 1 Spool_Dn 2 X2 66 Y2 51 Spool_Up 3 Spool_Dn 4 In 
Band 1 Init# 1 Passes 5 % 1 ! descriptive comment
This defines a layout of four threads (a box), with one corner at (19,50) and the other 
corner at (66,51).
The thread spiraling up the rod passing through the first corner uses spool 1.  The one 
through the second corner uses spool 3.
The thread spiraling down the rod passing through the first corner uses spool 2.  The one 
through the second corner uses spool 4.
Each new pass will be wrapped on the inside of the previous box.  The first pass consists 
of a box that is 1 thread wide.  4 extra passes will be made and square spacing is used (% 
1).
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Thread Colors

Along the top of the screen is the Spools toolbar.  This shows the colors assigned to 
VisualWRAP’s eight spools, and also shows the colors assigned to the handle, endwraps 
and rod used by the 3D View window.  To change any of these colors, double-click on 
the item in the toolbar. 

Double-clicking an item in the Spools toolbar marks that item as ready to be changed, 
and launches the Library window.  On startup, VisualWRAP loads a thread library and 
will continue to use this library until you load a different one.  It is possible to modify the 
existing library or create new ones.

Each library can contain an unlimited number of colors.

Note: The colors used in each VisualWRAP library are approximations to actual thread colors.

Changing Spool Allocations

? Double-click on the item in the Spools toolbar you wish to change.
? Scroll through the library until you find an appropriate color and double-click on it.  Alternatively, 

click on it once then click on the spool button in the Library toolbar.

Adding Colors to a Library

? Launch the library by double-clicking on “More Colors” in the Spools toolbar.
? Click on either the “new” button on top of the colors column or on the Library toolbar.
? Click on the “Define Color” button in the “Color” window.
? Click on a Basic color, or click on the “Define custom colors” button and mix your own color 

using the palette crosshair and brightness slider, then click on “Add to custom Colors” and finally 
click on the custom color you just created.

? Click on OK, give your new color a name and click the “Accept” button.
? Scroll down to the bottom of the library and you will see your new color.

To make your new color available next time you run VisualWRAP, click on the Save 
button in the Library toolbar.

Creating New Libraries

To create a new library you can either edit an existing library and save it with a new 
name, or create a brand new library.



Page 13 of 31

VisualWRAP Help File
Copyright 2001, 2002 David Boyle

www.visualwrap.com

To edit an existing library, launch the library by double-clicking on the “More Colors”
button in the Spools toolbar then do one or more of the following:

? To load another existing library click on the Open button in the Library toolbar.
? Add new colors using the “new” button on top of the colors column or on the Library toolbar.
? Delete a color by clicking on it once then clicking on the Delete button in the Library toolbar.
? Save the library with a different name using the Save button in the Library toolbar.

To create a brand new library:
? Launch the library by double-clicking on the “More Colors”  button in the Spools toolbar
? Click on the Open button in the Library toolbar.
? Double-click on library called “Blank.lib”.  Choose “Yes”  to clear the existing colors first.
? Add new colors using the “new” button on top of the colors column or on the Library toolbar.

The website (www.visualwrap.com) may contain additional thread libraries available for 
download.  If you create a useful library you may wish to submit it to the website to share 
it with others.

When you shut down VisualWRAP, the current spool allocations will only be saved if the 
appropriate preference has been set.  Look at the Loaded Colors section of the “Threads”
tab on the Preferences window.  A similar preference allows VisualWRAP to modify the 
Spool allocations to match those saved with each pattern script.  (The spool allocations
are saved with each pattern script, even though these allocations do not appear in the 
Script window).
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The Flat View Window

The Flat View window is a flattened-out representation of a section of rod.  The Flat 
View is where VisualWRAP draws lines representing threads according to the loaded 
script.

By default, the Flat View appears in the top half of the screen when VisualWRAP is 
started.

The Flat View window has the controls for wrapping patterns.  The right-hand side 
toolbar has the wrapping mode buttons: Auto / Delay / Single.  The left-hand side toolbar 
has the wrapping control buttons: Wrap / Clear / Next

Note: A pattern must appear in the Flat View window before it can appear in either the 3D View or the 
Taper View.

Wrapping Modes

VisualWrap has three modes of wrapping: Auto, Delay and Single.
? In Auto mode, VisualWRAP wraps the patterns as quickly as possible.
? In Delay mode, a time delay is placed between each thread.  This time delay is adjustable and is 

accessed using the Preferences window (see the Flat View section on the “Wrapping” tab of the 
Preferences screen).

? In Single mode, once the wrap is started, subsequent threads are laid in response to a click on the 
“Next”  button, a press of the spacebar, or the Enter key.

Note:  If using Single mode wrapping, use the Preferences window to enable the option “Give confirmation 
message when wrapping is complete” so you know when the wrap has completed.  This is found in the 
Script Tracking section of the “Wrapping tab.

Note:  Wrapping modes can be changed mid-way through a wrap by clicking on the desired mode button.

Wrapping Controls

A wrap is started by clicking the Wrap button.  A script needs to be loaded in the Script 
window before wrapping can take place.  Clicking the Wrap button loads the current 
script into memory.  Changes made to a script mid-way through a wrap will have no 
effect until the current wrap is finished and the Wrap button is clicked again.

If unwanted gaps appear between adjacent threads in the Flat View window, try changing 
the Thread Width settings on the “Threads” panel of the Preferences window.
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Note:  If the Zoom window is visible, the pattern will be wrapped in the Zoom window.  Otherwise it will 
appear in the Flat View window.

If  Single mode is selected, each new thread is placed using the Next button.  (The wrap 
must first be started using the Wrap button.)  Once the Next button has been clicked once, 
remaining threads can be laid by clicking Next again, pressing the spacebar, or pressing 
the Enter key.  Hold down the Enter key to lay threads quickly.

Use the Clear button to remove pattern threads from the Flat View.  By default the rod 
color is used to repaint the Flat View.  If Underwrapping is enabled (see the Flat View 
section of the “Wrapping” tab) then the underwrap color is used to paint the Flat View.

Line Comments

The “Current Thread” box appears at the bottom of the Flat View window in the middle 
of the screen.  (If this is not visible it may be enabled using the Preferences window.  See 
the Script Tracking section on the “Wrapping” tab and select “Display line comments 
while wrapping.”)  As the pattern is wrapped, the descriptive comment from the current 
line of script is displayed here.

Pattern Size

By default the Flat View is a square that represents a single pattern.  More or less of the 
pattern may be viewed using the “+” and “-“ buttons in the toolbar at the top of the 
screen.  The number between the “+” and “-“ buttons represents how many patterns will 
be visible if the pattern script uses square spacing (ie. spacing = 1).  Every time the 
pattern size is changed the Flat View is cleared.  To see the pattern again, use the “Wrap”
button.

Note:  The pattern sizing buttons only affect the Flat View window.  They have no effect 
on the Zoom window.
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The Zoom Window

The Zoom window shows a magnified view similar to the Flat View.  The Zoom window 
is launched from the “Window” menu.

The Zoom window is of a fixed size, and there are no controls on the form.  Use the 
controls on the Flat View window to wrap a pattern in the Zoom window.

If unwanted gaps appear between adjacent threads in the Zoom window, use the Thread 
Width settings on the “Threads” panel of the Preferences window.

The 3D View Window

The 3D View window shows a three-dimensional rod, textured with your choice of colors 
for the handle, rod and end wraps (the short tie-down wraps at either end of the cross 
wrap), and decorated with the cross wrap pattern from the Flat View window.  The 3D 
View window allows you to view the rod from any position in space.

The 3D View window is launched using the “3D” button in the toolbar along the top of 
the screen, or using the “Window” menu and choosing “3D Viewer”.  It may take a few 
moments for the 3D rod to generate then display.  When it appears you will see the 
default view of the rod, spinning in a horizontal position.

Note: Before the 3D View can display patterns you need to install the Cortona VRML 
Client.  This is available as a free download from www.parallelgraphics.com .

Views

The right-hand side toolbar of the 3D View window has Min, Max and Refresh buttons:
? Max makes the view occupy the whole screen.  Please minimize this window once you have 

finished with it.
? Min reduces the view to the default window size.
? Refresh regenerates the default view, and applies any changes you have made to the cross wrap 

pattern or the rod colors.

Note:  Occasionally an error message (“unable to display page”) appears briefly in the 3D View window
while the latest view is being generated.  This is normal.

The bottom menu of the 3D View window has the following items:
? goto – click here then click on a region of the rod to zoom in to.
? align – not used.  Gives unpredictable results.
? view – gives a selection of three pre-defined views



Page 17 of 31

VisualWRAP Help File
Copyright 2001, 2002 David Boyle

www.visualwrap.com

? restore – regenerates the default view.
? fit – zooms in to show the entire rod.

Positioning

The rod is shown at a fixed position in 3D space.  To view the rod from a different angle, 
change the position of the camera.  The camera position is effectively the position from 
which you view the rod.  Do this by dragging the background of the 3D View window 
with the mouse clicked.  The change in camera position depends on what mode of 
navigation is chosen.

The side menu of the 3D View window allows selection of the following navigation 
modes:

? walk / fly / study
? plan / pan / turn / roll

A combination of these options determines the behaviour of the rod when you click and 
drag the background of the 3D View.
Choose the modes “study” and “turn” to have the rod twist on its axis when you click and 
drag the background.  This is the most useful mode to work with.  Experiment with the 
other modes to see what effects are possible.  If you lose sight of the rod at any time you 
can choose “restore” or “Refresh” to return to the original view.

Hotspots

The rod has a number of “hotspots” defined.  When you click on various parts of the rod 
you can make things happen.

? Click on the handle to stop the rod from spinning.
? Click on the rod just in front of the handle to start the rod spinning.
? Click on the cross wrap to cycle through one of twelve available background colors

Right-Click Menu

Right-clicking on the 3D View launches the Cortona VRML Client menu.  It is the 
Cortona Client that enables VisualWRAP to display 3D images.  VisualWRAP uses 
Cortona’s default settings.  You may modify these using the right-click menu, but be 
aware that this menu is not part of the VisualWRAP software and technical support 
available may be limited or not available.
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The Pattern Script Window

The Pattern Script window is a text editor that displays the currently loaded pattern script.
On startup this window appears in the lower half of the screen.  When hidden by other 
windows, the Pattern Script window is restored using the Script Window button in the 
main toolbar (“horizontal parallel lines” icon), or by using the “Window” menu.

Pattern Script Toolbar

? Open – loads an existing pattern script
? Save – saves the current script
? New – clears the current script
? Print – prints the current script.  (As an alternative you can open a pattern script using a word 

processor, format it to suit your needs and print it from there.)
? Scope – enables/disables sections of the script.  Only enabled sections are wrapped.  (If any lines 

have been commented out using “!” then the scope function may give unpredictable results.)
? All Threads / Layouts Only – sets which threads to wrap.
? Tartan – allows thread color mixing, simulating the tartan effect of not using color preserver on

regular thread.
? Builder – launches the Script Builder.  This is the recommended method for creating pattern 

scripts.

Syntax Highlighting

The Pattern Script window uses color syntax highlighting that formats the script to make 
it easier to read.  The rules that govern this highlighting are:

? Comments (text starting with an exclamation mark), heading key words (Title: and Section:), and 
associated descriptive text is shown in green italics.

? Layout key words and Progression key words are shown bold in light blue.
? Numbers are shown in black.
? Remaining text is shown in dark blue.

Text-Editing Keystroke Commands

The Pattern Script window recognizes standard text-editing command keystrokes such as 
copy, cut, paste, find and replace as listed in the following table.
Note: There are often different ways of achieving the same command.

Command Keystroke
CharLeft Left
CharLeftExtend Shift + Left
      CharRight Right
CharRightExtend Shift + Right
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Copy Control + C
Copy Control + Insert
Cut Shift + Delete
Cut Control + X
CutSelection Control + Alt + W
Delete Delete
DeleteBack Backspace
DocumentEnd Control + End
DocumentEndExtend Control + Shift + End
DocumentStart Control + Home
DocumentStartExtend Control + Shift + Home
Find Alt + F3
Find Control + F
FindNext F3
FindNextWord Control + F3
FindPrev Shift + F3
FindPrevWord Control + Shift + F3
FindReplace Control + Alt + F3
GoToLine Control + G
Home Home
HomeExtend Shift + Home
LineCut Control + Y
LineDown Down
LineDownExtend Shift + Down
LineEnd End
LineEndExtend Shift + End
LineOpenAbove Control + Shift + N
LineUp Up
LineUpExtend Shift + Up
PageDown Next
PageDowNextend Shift + Next
PageUp PRIOR
PageUpExtend Shift + Prior
Paste Control + V
Paste Shift + Insert
Properties Alt + Enter
RecordMacro Control + Shift + R
Redo Control + A
SelectLine Control + Alt + F8
SetRepeatCount Control + R
ToggleOvertype Insert
ToggleWhitespaceDisplay Control + Alt + T
Undo Control + Z
Undo Alt + Backspace
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WindowScrollDown Control + Up
WindowScrollLeft Control + PageUp
WindowScrollRight Control + PageDown
WindowScrollUp Control + Down
WordDeleteToEnd Control + Delete
WordDeleteToStart Control + Backspace
WordLeft Control + Left
WordLeftExtend Control + Shift + Left
WordRight Control + Right
WordRightExtend Control + Shift + Right

Many of these commands are available by right-clicking on the Pattern Script window 
and using the popup menu.  Please be aware that the right-click menu may allow you to 
change some settings for the Pattern Script window, but these settings are not saved when 
VisualWRAP is shut down.
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The Script Builder

The Script Builder is used for generating and editing lines of script.  It is launched using 
the “hammer and spanner” button on the main toolbar or on the Pattern Script window 
toolbar, or using the “Window” menu. 

The Script Builder is a template that represents a line of script as buttons and text fields.
You configure the Builder to represent the layout and progression you want, and it 
generates the script.  The script is then added to the Script Window in the position you 
indicate.

As you make selections on the Builder, the generated script is displayed in the Preview 
field at the bottom of the screen.  The script is only sent to the Script Window using the 
INSert, REPlace or APPend buttons in the Script Builder toolbar.

The easiest way to learn about the Script Builder is to launch the Script Builder Help 
Wizard, using the large question mark “?” at the bottom of the toolbar.  This wizard is 
like a step-by-step coach that helps you configure the Builder.

Note: There are two question mark “?” icons on the Script Builder form.  One is in the 
right-hand side toolbar down the side of the form, and the other is along the top of the 
form.  The large icon at the bottom of the right-hand side toolbar launches the Script 
Builder Help Wizard.  The small icon at the top of the form launches “What’s This” help.
To use “What’s This” help, click on the small icon then click on any item in the Script 
Builder form you want help on.  A small text box will pop up and give a brief description 
of the selected item.

The “*S” button in the toolbar creates a new Section in the Pattern Script.

The “Place” check box in the bottom-left corner of the form lets you use the mouse to 
specify X Y co-ordinates.  When the Place box is checked you can move the mouse over 
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the Flat View window and the co-ordinates in the Script Builder form will automatically 
update.  Click the mouse over the Flat View to set the co-ordinates.  Two clicks are 
needed when a Box layout is chosen.  A “ghost” thread follows the mouse as a visual 
indication of the thread(s) being placed.  This ghost thread passes through the co-
ordinates of the mouse and at an angle determined by the layout Spacing.  (The Spacing 
box is at the top of the Script Builder form, beneath the “Thread Layout” heading.)

Editing Existing Script

To edit existing script from the Pattern Script window, either use the mouse to highlight 
the portion to be changed and re-type it, or click once on the line of script and then 
launch the Script Builder.  The Builder will appear already configured with all of the 
information from the selected line of script.  Make the change on the Builder and click 
the “REPlace” button in the Builder toolbar.
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The Taper View Window

The Taper View window shows the pattern from the Flat View window affected by rod 
taper.  This window is used when printing the pattern image.  To launch the Taper View 
window, use the Taper View button (sloping lines icon) on the main toolbar or use the 
“Window” menu.

The image in the Taper View window is derived from the Flat View.  You need to wrap a 
pattern in the Flat View before you can view it here.

The text fields along the bottom of the form are where you specify the diameters for the 
butt and tip ends of the wrap.  VisualWRAP calculates the Screen wrap length, which is 
the length of the wrap if the pattern is to appear in the same proportions as shown on the 
screen.  (It is calculated by multiplying the mid-circumference of the wrap by the number 
of patterns selected.)  You may override the Screen length by typing a new length in the 
Print length box. (Select the Print option button first.)  This only affects the length of the 
printed image, and has no effect on the image appearing on the screen.

The left-hand side toolbar has the following buttons:
? Refresh – takes the image from the Flat View and distorts it to account for rod taper.  If you make 

a change to the Flat View pattern while the Taper View is visible you will need to use the Refresh 
button.

? Spacing – launches the Spacing List based on the size of the pattern.
? Print – sends the Taper View image to the printer, scaled to either the Screen or Printer wrap 

length, depending on the selection.

Taper Tuning

The Taper View uses an approximate graphical manipulation to transform the Flat View 
image into the Taper View image.  As it is a graphical technique, sometimes the image 
quality of the Taper View is not very sharp.  One particular effect that can occur is the 
appearance of vertical lines in the Taper View.  There is a way to overcome this and it is 
called Taper Tuning.

If the Taper View image has vertical lines through it, double-click on the image and the 
Taper Tuning window will appear.

VisualWRAP
uses scale 
factors to 
generate the 
Taper View 
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image.  If the currently stored scale factor does not suit your particular PC then vertical 
lines may appear in the image.

Click on the up or down arrows and see how the image quality of the Taper View 
changes.  Once you find a setting where the vertical lines disappear and the image quality 
is acceptable, click on the tick button. This stores the scale factor for the current screen 
and pattern size.

You may find that you have to repeat this process if you display a different number of 
patterns, if the amount of taper varies, or the screen size is changed.

Spacing List

The Spacing List calculates the distance between centers of a square pattern.  If the 
pattern is not square (eg. A fish pattern with elongated or compressed spacing) then the 
spacings listed will not be appropriate.

When the Spacing List is launched, click on the “Recalc” button to ensure it is loaded 
with the latest data.

The spacing list uses the data from the Taper View window plus the number of patterns 
currently displayed.  It displays spacings for the 0 and 180 degree axes (front and back of 
the pattern).  If you change the number of patterns (using the “+” or “-“ buttons in the 
main toolbar) then the spacing list is recalculated.  The overall length of the pattern is 
either the Screen wrap length or the Printer wrap length, depending on the selection.  If 
you change the Printer wrap length you may need to click on the “Recalc” button to 
recalculate the spacings based on the new length.

The “2D Draw” button in the Spacing List toolbar draws the cumulative spacing 
calculation onto the Flat View window.  To remove it, rewrap the pattern.

Note: The Spacing list does its calculations based on the length of the wrap, number of patterns and taper 
of the rod.  It is not necessary for a pattern to be loaded or showing in the Flat View in order to use the 
Spacing List.
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The Preferences Window

Some features of VisualWRAP may be enabled or disabled depending on your 
preference.  The Preferences window gives access to these settings and is launched from 
the User Preferences button (checked box icon) in the main toolbar or using the 
“Window” menu.

When a preference is changed, the “Apply” button on the Preferences form becomes 
active.

? Click on the Apply button to accept all new preferences and keep the Preferences form open.
? Click on the OK button to accept all new preferences and close the Preferences form.
? Click on the Cancel button to reject all new preferences and close the Preferences form.

The Preferences form is divided into tabs (categories), and in each category there are 
several available options.  Following is a description of these.

Wrapping

Script Tracking options:
? “Track lines of code while wrapping” – when selected, a highlight traces progress through the 

script as a pattern is wrapped.  Delay or Single mode wrapping is required to see this properly.
? “Display line comments while wrapping” – when selected, a status box appears below the Flat 

View and line comments appear here as a pattern is wrapped.  Delay or Single mode wrapping is 
required to see this properly.

? “Give confirmation message when wrapping is complete” – when selected, a message box advises 
when the pattern has finished wrapping.  Useful when Single mode wrapping is used.

 Flat View options:
? “Time delay between each thread” – specifies the time delay between threads in Delay mode.
? “Use an underwrap” – when selected, an underwrap box appears in the Spools toolbar and this 

color is used to paint the Flat View when the Clear button is clicked.
? “Display (x,y) tooltip when mouse is over the pattern” – when checked, the mouse co-ordinate

appears in a popup (tooltip) over the Flat View window.

Threads

 Loaded Colors options:
? “When loading a pattern load colors as well” – spool colors saved with the pattern are loaded 

when the pattern is loaded.
? “When closing, remember current colors for next time” – saves the current spool allocations.

Thread Width options:
You can use a thicker or thinner style of thread when wrapping patterns on the screen.
This helps to account for varying graphics capabilities of different computer systems.  If 
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gaps appear between adjacent threads, try using a thicker thread and wrap the pattern 
again.

Printing

Tapered Pattern Printing Scale Factors
By default, these are both 1.  If you find that the printed size of the tapered pattern does 
not match the size you specified, try using a scale factor to compensate.
Eg. If the specified printed length is 145mm, but the measured printed length is 140mm 
then make the “Length” scale factor equal to 1.04 (ie. 145/140). 
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The Tools Menu
The tools menu allows you to save an image of the Flat View window, and then restore it 
later.  This lets you show someone your pattern without having to share your script.

Choose “Save Image” to save the current image in the Flat View window.
Choose “Restore Image” to load an image into the Flat View window.

Note:  The saved image will be the size of the Flat View window when it was saved.
Attempting to load a saved image into a Flat View window of a different size will not 
stretch the image to suit.  If you use a naming convention which includes the pattern size 
when saving an image it may reduce confusion.  Eg. To save an image of a pattern when 
the Flat View window is 3 patterns wide, call the saved image YourImageName_3.  When 
loading this image, set the pattern size to 3 first.  This is just a suggestion.

Wrapping Instructions

The Wrapping Instructions show a graphical, section-by-section breakdown of the cross 
wrap, based on the pattern script.  These instructions may be printed and used as a 
reference, in conjunction with the pattern script, when you are ready to wrap the pattern 
on a rod.  Wrapping Instructions are launched using the Wrapping Instructions button 
(boxed 1 2 icon) on the toolbar at the top of the screen, or using the “Window” menu.

Each section of the pattern script is represented on the Wrapping Instructions form by a 
panel showing three images:

1. The layout threads of the current section shown in isolation
2. The layout threads shown added to the current pattern
3. The state of the pattern after the current section is wrapped

Each panel is annotated with the title of the current section.

One form can show a maximum of five sections.  If more sections are present then 
multiple forms are generated.

Note:  When printing the Wrapping Instructions, use Portrait page orientation.  If multiple forms are 
generated, each needs to be printed separately.
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Frequently Asked Questions

Q Where do I start?
A This help file is a good starting place.  Also take a look at the Help Wizard.  It 
guides you through various tasks

Q How do I see a pattern?
A Load an existing script (or write your own).  Wrap it to see it appear in the Flat 
View window.  Launch the 3D View window to see it in 3D. 

Q How do I load an existing pattern?
A Click on the File\Open Script menu and choose a pattern.  There is also an Open 
File icon in the Script Window toolbar.

Q How do I print a pattern?
A 1. To print the pattern script, click on the print icon on the Pattern Script window.
Alternatively you can open the script (as a text file) in a word processor and print it from
there.

2. To print an image of the pattern, launch the Taper View window, set the butt 
and tip diameters for the pattern, the length of the wrap, then click refresh.  You can now 
use the Print icon in the Taper View toolbar to print the image.

Q How do I change colors in a pattern?
A There are two ways:

1. Double-click on a spool in the Spools toolbar and change it to another color.
2. Change the spool number used in the script.  This is probably a better way.

Q How can I hide the handle in the 3D view?
A If the background is black, change the handle color to black.  Using other 
background colors might not work as well.

Q Can I save a bitmap image of the pattern?
A Yes.  Use the Tools menu.  This saves the image from the Flat View window.

Q Where do I get more help and more patterns?
A Visit the website www.visualwrap.com
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Support

VisualWRAP is a new product and there are bound to be many improvements that can be 
made.  Please visit the website www.visualwrap.com and provide feedback on problems, 
suggestions or questions you have.

Happy Wrapping!

Screen Shots
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(The maze pattern was supplied by Steve Parks)


